CoolSculpting Marketing Services
Emerson Medical - Dr. Natalya Chalik Q1 2021
Total Marketing Expenses
(1/1/2021 - 3/31/2021)

Total Google Ads:
Total Marketing Service Fees:
Total CoolSculpting Marketing Cost:

3,277.04
3,099.60
6,376.64

P hH AR

_— Chris Zelig » o 259-215-0574 Chris Zelig
= A4 Google Ads | gmersonMedical- .. ssosus7es ~ | All campaigns C @ & .puemecsmedtocon
Overview & Campaigns Custom Jan1-Mar31,2021 ~ < >
Recommendation:
ecommendations | Ly Campaign status: Al ADD FILTER Q m @ ¥ O | v
Insights
Ij ® Campaign Budget Status Clicks CTR \J Cost
~ Campaigns
0 e Y search| beta | coolsculpting $48.83/day [ Eligible 942 7.31% $3277.04
I Campaigns #f
0] e Y search| beta | weight loss $18.07/day [ Eligible 575 9.01% $1,503.50
Auction insights
0 o Y CoolSculpting Main Exact $70.00/day Paused 0 - $0.00
» Ad groups
D 1 o [ CoolSculpting Main #3 $30.00/day Removed 0 - $0.00
» Ads & extensions -
i [ o [ Coolsculpting Main #2 $30.00/day Removed 0 - $0.00
» Landing pages i
Kevwords [ [/] m CoolSculpting Main-BMM $25.00/day Paused 0 - $0.00
» Keywor =
M CoolSculpting Main Exact oy g
» Audiences (i Q) Target CPA Experiment - CoolSculpting Main $70.00/day Ended 0 $0.00
» Demographics 0O o Y search| beta| coolsculpting OLD $85.06/day Paused 0 - $0.00
» Settings 0O o Y search beta| coolsculpting | broad $30.00/day Paused 0 - $0.00
Suggested 0 o Y search | beta| coolsculpting | exact $25.00/day Paused 0 = $0.00
> Ad schedule Total: Campaigns ® 1517 787% $4780.54
+ More . =
v Total: Account (@D $66.90/day 1517 7.87% $4,780.54

= 4 G | Ad Chris Zelig > All campaigns > ‘ 259-215-0574 Chris Zelig
- 00gle AQS | EmersonMedical - ... 5503346766 ¥ search | beta | coolsculpting support@medstarmedia.com
VeI @ Enabled Status: Eligible  Type: Search Budget: $48.83/day Optimization score: 73.4% NN More details v
Recommendations Ads v <D
Insights
9 + Y Adstatus: Al ADD FILTER Q v
» Ad groups
0O e Ad Ad group Status Clicks CTR J Cost
~ Ads & extensions
Emerson Medical | Fat Reduction on Staten Island | Non-
I Ads Surgical Fat Reduction +6 more s
— www.natalyachalikmd.com Eligible (Limited) ) 5
U e Easy And Convenient. Long-Lasting. Minimal Downtime 3.lipo Poor ad strength 122 B.03% 3627
Extensions Real Success Stories. FDA Cleared. Best Prices. FDA-. 7T
View assets details
D » Landing pages Emerson Medical | Fat Reduction on Staten Island | Non-
Surgical Fat Reduction +6 more
» Keywords D L g;::izztcagzscfxlwllker:tdfgn";»Lastmg. Minimal Downtime. x. Expanded Reach Test Eligible 85 6.25% $249.50
Real Success Stories. FDA Cleared. Best Prices. FDA-..
» Audiences View assets details
. Fat Reduction on Staten Island | Our Biggest Discount
> Demographics Ever | Get $1000 Off 6+ Treatments
= wwiw.natalyachalikmd.com »
Settings |—| L Easy And Convenient. Long-Lasting. Minimal Downtime 3.lipo EJ{Q@!? 7 93%% 315526
g Real Success Stories. FDA Cleared. Is Freezing Fat Right
For You? Book a Free CoolSculpting Consultation Today
Suggested
Fat Reduction on Staten Island | Our Biggest Discount
» Ad schedule Ever Free!ze Awlai Body Fat
M www.natalyachalikmd.com 2 3
U e Ea‘:, And Cyonvement Long-Lasting. Minimal Downtime % Expended Beach Test Eghle 2 021% $140.86
+ More L Real Success Stories. FDA Cleared. Is Freezing Fat Right

For You? Book a Free CoolSculpting Consultation Today

Fat Reduction on Staten Island | Our Biggest Discount

- Chris Zelig > All campaigns > ‘ 259-215-0574 Chris Zelig
= Emerson Medical - .. 5503346766 ¥ search | beta | coolsculpting media.com
Overview @ Enabled Status: Eligible Type:Search  Budget: $48.83/day Optimization score: 73.4% I = More details v
Recommendations + Y Adstatus: Al ADD FILTER Q = mm . L ‘ v
Insights
O e Ad Ad group Status Clicks CTR J Cost
» Ad groups

Fat Reduction on Staten Island | Our Biggest Discount
N e Ever | Get Rid of Unwanted Fat
28 ! www.natalyachalikmd.com o i ;
%,
D ® Easy And Convenient. Long-Lasting. Minimal Downtime 3.lipo Elighle L 78%% $107.13
Ads Real Success Stories. FDA Cleared. Is Freezing Fat Right
For You? Book a Free CoolSculpting Consultation Today
Extensions Fat Reduction on Staten Island | Our Biggest Discount
Ever | Get $1000 Off 6+ Treatments
www.natalyachalikmd.com Ry ;
D » Landing pages 0 e Easy And Convenient. Long-Lasting. Minimal Downtime. x.Expanded heach Test Elgole 3 751% $10206
Real Success Stories. FDA Cleared. Is Freezing Fat Right
For You? Book a Free CoolSculpting Consultation Today

* Keywords

Fat Reduction on Staten Island | Our Biggest Discount
» Audiences Ever | Freeze Away Body Fat
M www.natalyachalikmd.com : -
|—| Easy And Convenient. Long-Lasting. Minimal Downtime 3. lipo Efigible 3 7.38% $98.50
* Demographics Real Success Stories. FDA Cleared. Is Freezing Fat Right
For You? Book a Free CoolSculpting Consultation Today
Scbiligs CoolSculpting in Staten Island | Save $1000 Off 6+
Treatments | Qur Biggest Discount Ever
Suggested www.natalyachalikmd.com
[] @ Expert, Safe Fat Loss With Quick Results. Minimal
» Ad schedule Downtime. Eliminate Fat And Feel Great. Don't Miss Our
Biggest Promo Yet. Book a Free Consultation and Lock In
Your Discount Today

coolsculpting - general Eligible 18 8.87% $91.80

n
u.

. Expanded Reach Test Eligible 22 547% §73.54

+ More .
Fat Reduction on Staten Island | Our Biggest Discount
Ever | Get Rid of Unwanted Fat

N e www.natalyachalikmd.com

)
=

— Chris Zelig > All campaigns > C 0 ‘ 259-215-0574 Chris Zelig
= Emerson Medical - ... 5503346766 ¥ search | beta | coolsculpting support@medstarmedia.com
i @ Enabled Status: Eligible  Type: Search Budget: 948.83/day Optimization score: 73.4% N More details v
Recommendations ~ + Y Adstatus:All ADD FILTER Q = m @M 3 3 ’ 4
Insights L
] ® Ad Ad group Status Clicks CTR J Cost
» Ad groups Real Success Stories. FDA Cleared. |s Freezing Fat Right

For You? Book a Free CoolSculpting Consultation Today

™ Ads &extensions Fat Reduction on Staten Island | Our Biggest Discount

Ever | Freeze Away Body Fat
Ads — wwaw.natalyachalikmd.com g o ;
I |—| L Easy And Convenient. Long-Lasting. Minimal Downtime. 3. lipo Eligible 3 7.38% $98.50
Real Success Stories. FDA Cleared. Is Freezing Fat Right
Extensions For You? Book a Free CoolSculpting Consultation Today
D » Landi CoolSculpting in Staten Island | Save $1000 Off 6+
L anding pages Treatments | Qur Biggest Discount Ever
www.natalyachalikmd.com
» Keywords 0O e Expert, Safe Fat Loss With Quick Results. Minimal 0. coolsculpting - general Eligible 18 8.87% $91.80
Downtime. Eliminate Fat And Feel Great. Don't Miss Our
Biggest Promo Yet. Book a Free Consultation and Lock In
» Audiences Your Discount Today
; ) Fat Reduction on Staten Island | Our Biggest Discount
Demographics Ever | Get Rid of Unwanted Fat
wwiw.natalyachalikmd.com . L o Y
Settings D ® Easy And Convenient. Long-Lasting. Minimal Downtime. #| *Expanded Reach Test Elghle 2 347% §73.54
Real Success Stories. FDA Cleared. Is Freezing Fat Right
For You? Book a Free CoolSculpting Consultation Today
Suggested
Fat Reduction on Staten Island | Our Biggest Discount
* Ad schedule Ever | Get Rid of Unwanted Fat
o www.natalyachalikmd.com
+ More . [ e Best Prices. FDA-Cleared. Clinically Proven Fat Removal. x. Expanded Reach Test Eligible 20 402% $66.15

No Surgery. Minimal Downtime. Our Biggest
CoolSculpting Discount Ever. Save $1,000 Off 6+
Treatments of CoolSculpting
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= 4 G | Ad Chris Zelig > All campaigns > c o ‘ 259.215.0574 Chis Zelig
= 00gl€ AGS | EmersonMedical - ... 5503346766 v | search | beta | coolsculpting Toouse support@medstarmedia.com
i @ Enabled Status: Eligible  Type: Search Budget: $48.83/day Optimization score: 73.4% N More details v
Recommendations Ads LR
Insights — ra
- + Y Adstatus:All ADD FILTER Q = m * o v
» Ad groups
] e Ad Ad group Status Clicks CTR J Cost
~ Ads & extensions
CoolSculpting in Staten Island | Limited Time Offer | Mar
Ads 2021 | Our Biggest Discount Ever
www.natalyachalikmd.com
D [x] Expert, Safe Fat Loss With Quick Results. Minimal 0. coolsculpting - general Removed 12 17.14% $65.63
Extensions Downtime. Eliminate Fat And Feel Great. Don't Miss Our
Biggest Promo Yet. Book a Free Consultation and Lock In
Your Discount Today
» Landing pages
CoolSculpting in Staten Island | Save $1000 Off 6+
» Keywords Treatments | Our Biggest Discount Ever
wwiw.natalyachalikmd.com
0O e Expert, Safe Fat Loss With Quick Results. Minimal 1. coolsculpting - price Eligible 1 18.33% $64.47
» Audiences Downtime. Eliminate Fat And Feel Great. Don't Miss Our
Biggest Promo Yet. Book a Free Consultation and Lock in
Your Discount Today
* Demographics
{KeyWord:Emerson Medical} | CoolSculpting in Staten
Settings Island | 2021 CoolSculpting Discount +7 more
www.natalyachalikmd.com — o ;
D L Best Prices. FDA-Cleared. Clinically Proven Fat Removal. 0: coolsculpting - general Eiighle L1 24k $61.71
Suggested No Surgery. Minimal Downtime. Leading CoolSculpting...
View assets details
* Ad schedule
Fat Reduction on Staten Island | Our Biggest Discount
Ever | Freeze Away Body Fat
+ More . www.natalyachalikmd.com
D ® Best Prices. FDA-Cleared. Clinically Proven Fat Removal. x. Expanded Reach Test Eligible 22 410% $59.79

No Surgery. Minimal Downtime. Our Biggest
CoolSculpting Discount Ever. Save $1,000 Off 6+

Teantmmantn af NanlCnilasina

= 4 G le Ad Chris Zelig > All campaigns > Py 259-215-0574 Chris Zelig
= 00gle AGS | Emerson Medical - .. 5503346766 ¥ search | beta | coolsculpting support@medstarmedia.com
S @ Enabled Status: Eligible  Type: Search Budget: $48.83/day Optimization score: 73.4% NN More details v
_ ) O\ — 3 ra
Recommendations 4 Y Adstatus Al ADD FILTER - s s ’ v
Insights H
0 e Ad Ad group Status Clicks CTR J Cost
» Ad groups
group Fat Reduction on Staten Island | Our Biggest Discount
Ever | Freeze Away Body Fat
~ Ads & extensions www.natalyachalikmd.com
D o Best Prices. FDA-Cleared. Clinically Proven FatRemoval. " x. Expanded Reach Test Eligible 22 4.10% $59.79
No Surgery. Minimal Downtime. Our Biggest
Ads CoolSculpting Discount Ever. Save $1,000 Off 6+
Treatments of CoolSculpting.
Extensions
CoolSculpting in Staten Island | Save $1000 Off 6+
Treatments | Flexible Payment Options
» Landing pages www.natalyachalikmd.com
0O e Expert, Safe Fat Loss With Quick Results. Minimal 1. coolsculpting - price Eligible 10 20.00% $55.91
Downtime. Eliminate Fat And Feel Great. Don't Miss Our
* Keywords Biggest Promo Yet. Book a Free Consultation and Lock In
Your Discount Today
* ‘Audiences CoolSculpting in Staten Island | Save $1000 Off 6+
Treatments | Flexible Payment Options
» Demographics www.natalyachalikmd.com
e Expert, Safe Fat Loss With Quick Results. Minimal 0. coolsculpting - general Eligible 10 495% $51.74
: Downtime. Eliminate Fat And Feel Great. Don't Miss Qur
Settings Biggest Promo Yet. Book a Free Consultation and Lock In
Your Discount Today
S ted
NggEste [Dynamically generated headline]
[Dynamically generated display URL]
> Ad schedule D PY Easy And Convenient. Long-Lasting. Minimal Downtime. T, Eligible g 11.94% $51.70

Real Success Stories. FDA Cleared. Ready To Say
Goodbye to Stubborn Fat? Schedule Your Free
Consultation Today.

+ More .

CoolSculpting in Staten Island | Limited Time Offer | Mar
2021 | Niir Rinneet Nierniint Fuar

All campaigns >
search | beta | coolsculpting

Chris Zelig »
Emerson Medical - ... 5503346766 ¥

259-215-0574 Chris Zelig
support@medstarmedia.com

= 4 Google Ads

Downtime. Eliminate Fat And Feel Great. Don't Miss Our
Biggest Promo Yet. Book a Free Consultation and Lock In
Your Discount Today

OvEnicw @ Enabled Status: Eligible  Type: Search Budget: $48.83/day Optimization score: 73.4% NN More details v
_— ra
Recommendations + Y Adstatus:All  ADD FILTER Q = m 0 - d ’ v
Insights
O e Ad Ad group Status Clicks CTR J Cost
» Ad groups Your Discount Today
= < [Dynamically generated headline]
Ads & extensions [Dynamically generated display URL]
Easy And Convenient. Long-Lasting. Minimal Downtime. X i
Ads D L Real Success Stories. FDA Cleared. Ready To Say ek Eligible 8 11.94% $51.70
Goodbye to Stubborn Fat? Schedule Your Free
Consultation Today.
Extensions
CoolSculpting in Staten Island | Limited Time Offer | Mar
: 2021 | Our Biggest Discount Ever
D > Landing pages wwaw.natalyachalikmd.com
D (<] Expert, Safe Fat Loss With Quick Results. Minimal 1. coolsculpting - price Removed 7 35.00% $50.39
» Keywords Downtime. Eliminate Fat And Feel Great. Don't Miss Our
Biggest Promo Yet. Book a Free Consultation and Lock In
Your Discount Today
» Audiences
Fat Reduction on Staten Island | Our Biggest Discount
' D i Ever | Get $1000 Off 6+ Treatments
emographics www.natalyachalikmd.com
0 e Best Prices. FDA-Cleared. Clinically Proven Fat Removal. x. Expanded Reach Test Eligible 19 372% $49.24
Settings No Surgery. Minimal Downtime. Our Biggest
CoolSculpting Discount Ever. Save $1,000 Off 6+
Treatments of CoolSculpting.
Suggested
CoolSculpting in Staten Island | Freeze Away Body Fat
* Ad schedule Flexible Payment Options
www.natalyachalikmd.com
Mo . 0] e Expert, Safe Fat Loss With Quick Results. Minimal 0. coolsculpting - general Eligible 9 12.50% $42.40

= 4 Google Ads

<+ More .

Chris Zelig >
Emerson Medical - ... 5503346766 ¥

Downtime. Eliminate Fat And Feel Great. Don't Miss Our
Biggest Promo Yet. Book a Free Consultation and Lock In
Your Discount Today

No Surgery. Minimal Downtime. Our Biggest
CoolSculpting Discount Ever. Save $1,000 Off 6+
Treatments of CoolSculpting

i [ g SR

All campaigns >
search | beta | coolsculpting

259-215-0574 Chris Zelig
support@medstammedia.com

= 4 G | Ad Chris Zelig > All campaigns > c o ‘ 259-215-0574 Chis Zelig
— 00gle AGS | Emerson Medical - .. 5503346766 ¥ | search | beta | coolsculpting support@medstarmedia.com
Overviow @ Enabled Status: Eligible  Type: Search Budget: 948.83/day Optimization score: 73.4% I More details v
Recommendations Ads >
Insights — R
- 4+ Y Adstatus:All ADD FILTER Q - m o .. b v
SEARCH  SEGMENT LUMNS ~ REPOATS DOWNLOAD  EXPAND
» Ad groups
0 e Ad Ad group Status Clicks CTR J Cost
~ Ads & extensions
[Dynamically generated headline]
I Ads [Dynamically generated display URL]
Best CoolSculpting Deal. Freeze Away Stubborn Fat. Top : i 3
D ® Provider in Staten Island, NY. How Much Does . dynamic Eligible 7 13:46% $41.83
Extensions CoolSculpting Cost? Less Than You Might Think. Book A
Free Consultation Now.
D » Landing pages CoolSculpting in Staten Island | Freeze Away Body Fat
Our Biggest Discount Ever
) www.natalyachalikmd.com
el 0 e Expert, Safe Fat Loss With Quick Results. Minimal 0. coolsculpting - general Eligible 12 14.63% $41.01
Downtime. Eliminate Fat And Feel Great. Don't Miss Our
» Audiences Biggest Promo Yet. Book a Free Consultation and Lock In
Your Discount Today
> Demographics Huge CoolSculpting Promotion | CoolSculpting in Staten
Island | 2021 CoolSculpting Discount +6 more
: www.natalyachalikmd.com _ 2 .
Settings D ° Best Prices. FDA-Cleared. Clinically Proven Fat Removal. 0. coolscilpting -general REmE 8 4% S4081
No Surgery. Minimal Downtime. Leading CoolSculpting...
Suggested View assets details
» Ad schedule CoolSculpting in Staten Island | Feb Only $1,000 Off 8+
Cycles | Our Biggest Discount Ever
www.natalyachalikmd.com
+ More L D (%] Expert, Safe Fat Loss With Quick Results. Minimal 0. coolsculpting - general Removed 13 10.32% $38.62

S @ Enabled Status: Eligible  Type: Search Budget: $48.83/day Optimization score: 73.4% NN More details v
— ra
Recommendations 4+ Y Adstatus Al ADD FILTER Q = m ¥ T ’ R
Insights i
] @ Ad Ad group Status Clicks CTR J Cost
» Ad groups
CoolSculpting in Staten Island | Feb Only $1,000 Off 8+
s Cycles | Flexible Payment Options
~ Ads & extensions wwiw.natalyachalikmd.com
[:] [x] Expert, Safe Fat Loss With Quick Results. Minimal 0. coolsculpting - general Removed 7 5.19% $37.61
I Ads Downtime. Eliminate Fat And Feel Great. Don't Miss Our
Biggest Promo Yet. Book a Free Consultation and Lock In
Your Discount Today
Extensions
CoolSculpting in Staten Island | Limited Time Offer | Mar
3 2021 | Flexible Payment Options
» Landing pages www.natalyachalikmd.com
D [x] Expert, Safe Fat Loss With Quick Results. Minimal 0. coolsculpting - general Removed 6 7.14% $35.27
» Keywords Downtime. Eliminate Fat And Feel Great. Don't Miss Our
Biggest Promo Yet. Book a Free Consultation and Lock In
Your Discount Today
» Audiences
Fat Reduction on Staten Island | Our Biggest Discount
Ever | Freeze Away Body Fat
* Demographics www.natalyachalikmd.com
D [ ] Best Prices. FDA-Cleared. Clinically Proven Fat Removal. 3.lipe Eligible 15 8.52% $§35.18
2 No Surgery. Minimal Downtime. Our Biggest
Settings CoolSculpting Discount Ever. Save $1,000 Off 6+
Treatments of CoolSculpting.
Suggested
Fat Reduction on Staten Island | Our Biggest Discount
* Ad schedule Ever | Get $1000 Off 6+ Treatments
www.natalyachalikmd.com
0 e Best Prices. FDA-Cleared. Clinically Proven Fat Removal. 3. lipo Eligible 12 7.10% $34.24




259-215-0574 Chris Zelig
support@medstammedia.com

Chris Zelig » All campaigns > ‘

=4 Google Ads Emerson Medical - ... 5503346766 ¥ search | beta | coolsculpting

@ Enabled Status: Eligible  Type: Search Budget: $48.83/day Optimization score: 73.4% I More details v

Overview
. : ra
Recommendations = -+ Y Adstatus Al ADD FILTER Q m @ o ’ <
Insights
] @ Ad Ad group Status Clicks CTR J Cost
» Ad aroups BIGUEST FTONMU YEL BOUK & FIEE CONSUITEmOn aia COCK 11T
Your Discount Today
~ Ads & extensions Fat Reduction on Staten Island | Our Biggest Discount
Ever | Freeze Away Body Fat
Ad www.natalyachalikmd.com
> 0] e Best Prices. FDA-Cleared. Clinically Proven Fat Removal. 3.lipo Eligible 15 8.52% §35.18
No Surgery. Minimal Downtime. Our Biggest
Extensions CoolSculpting Discount Ever. Save $1,000 Off 6+
Treatments of CoolSculpting
D » Landing pages Fat Reduction on Staten Island | Our Biggest Discount
Ever | Get $1000 Off 6+ Treatments
www.natalyachalikmd.com
* Keywords 0 e Best Prices. FDA-Cleared. Clinically Proven Fat Removal. /' 3.lipo Eligible 12 7.10% $34.24
No Surgery. Minimal Downtime. Our Biggest
» Audiences CoolSculpting Discount Ever. Save $1,000 Off 6+
Treatments of CoolSculpting.
* Demographics [Dynamically generated headline]
[Dynamically generated display URL]
2 Best Prices. FDA-Cleared. Clinically Proven Fat Removal. ; s ?
Settings D ® No Surgery. Minimal Downtime. Fat Reduction Treatment. X. dynamic Eligible 8 1569% $33.54
Target Belly Fat & Love Handles. Book a Free
Suggested Consultation.
» Ad schedule CoolSculpting in Staten Island | Limited Time Offer | Feb
2021 | Our Biggest Discount Ever
www.natalyachalikmd.com
+ More a 0O e Expert, Safe Fat Loss With Quick Results. Minimal 0. coolsculpting - general Removed 6 13.04% $31.79

Downtime. Eliminate Fat And Feel Great. Don't Miss Our
Biggest Promo Yet. Book a Free Consultation and Lock In
Your Discount Today

259-215-0574 Chris Zelig

Chris Zelig » All campaigns > ‘
support@medstammedia.com

=4 Google Ads | Emerson Medical - .. 5503346766 + search | beta | coolsculpting

@ Enabled Status: Eligible  Type: Search Budget: $48.83/day Optimization score: 73.4% NN More details v

Overview
Recommendations Ads v K
Insights — n .
- 4+ Y Adstatus:All ADD FILTER Q - m Mo .. L4 : v
» Ad groups
0 e Ad Ad group Status Clicks CTR J Cost
~ Ads & extensions
CoolSculpting in Staten Island | Limited Time Offer | Feb
Ads 2021 | Flexible Payment Options
www.natalyachalikmd.com
D (%] Expert, Safe Fat Loss With Quick Results. Minimal 0. coolsculpting - general Removed 8 21.62% $26.85
Extensions Downtime. Eliminate Fat And Feel Great. Don't Miss Our
Biggest Promo Yet. Book a Free Consultation and Lock In
Your Discount Today
» Landing pages
Non-Surgical Fat Reduction | Our Biggest Discount Ever
» Keywords Get Rid of Unwanted Fat
wwiw.natalyachalikmd.com -
D ° Easy And Convenient. Long-Lasting. Minimal Downtime. x. Expanded Reach Test Elighie 10 7% $2671
» Audiences Real Success Stories. FDA Cleargd. Is Freezing Fat Right
For You? Book a Free CoolSculpting Consultation Today
> Demographics Fat Reduction on Staten Island | Our Biggest Discount
Ever | Get Rid of Unwanted Fat
Settings www.natalyachalikmd.com
g 0 e Best Prices. FDA-Cleared. Clinically Proven Fat Removal. 3.lipo Eligible 8 491% $26.32
No Surgery. Minimal Downtime. Our Biggest
Suggested CoolSculpting Discount Ever. Save $1,000 Off 6+
Treatments of CoolSculpting.
* Ad schedule
Non-Surgical Fat Reduction | Our Biggest Discount Ever
40 Freeze Away Body Fat
ore . i
[] @ /oo x. Expanded Reach Test Eligible 7 6.48% $25.98

Easy And Convenient. Long-Lasting. Minimal Downtime. | &~~~ | ==
Real Success Stories. FDA Cleared. Is Freezing Fat Right
For You? Book a Free CoolSculpting Consultation Today

Chris Zelig » All campaigns >

A Goode Ad 259.215-0574 Chis Zelig
= 00gle AGS | Emerson Medical - .. 5503346766 ¥ search | beta | coolsculpting

support@medstarmedia.com

@ Enabled Status: Eligible  Type: Search Budget: $48.83/day Optimization score: 73.4% NN More details v

Overview
i o ;
Recommendations + Y Adstatus:All  ADD FILTER Q = m 0 - d : ’ v
Insights
O e Ad Ad group Status Clicks CTR J Cost
» Ad groups
Non-Surgical Fat Reduction | Our Biggest Discount Ever |
N Freeze Away Body Fat
~ Ads & extensions www.natalyachalikmd.com af o :
D e Easy And Convenient. Long-Lasting. Minimal Downtime. 3. ipo E j[g]@)]g 3 1521% $2580
Real Success Stories. FDA Cleared. Is Freezing Fat Right
Ads For You? Book a Free CoolSculpting Consultation Today
Extensions {KeyWord:Emerson Medical} | CoolSculpting in Staten
Island | 2021 CoolSculpting Discount +7 more
www.natalyachalikmd.com S— oo ;
D » Landing pages D L Best Prices. FDA-Cleared. Clinically Proven Fat Removal. 1. coolsculpting - price Eligible 6 19.35% 52379
No Surgery. Minimal Downtime. Leading CoolSculpting...
View assets details
*» Keywords
CoolSculpting in Staten Island | Jan Only $1,000 Off 8+
» Audiences Cycles | Flexible Payment Options
www.natalyachalikmd.com
D [x] Expert, Safe Fat Loss With Quick Results. Minimal 0. coolsculpting - general Removed 6 7.32% $23.60
* Demographics Downtime. Eliminate Fat And Feel Great. Don't Miss Our
Biggest Promo Yet. Book a Free Consultation and Lock In
: Your Discount Today
Settings
Non-Surgical Fat Reduction | Our Biggest Discount Ever |
Suggested Get 31000 Off 6+ Treatments

* Ad schedule

www.natalyachalikmd.com
Easy And Convenient. Long-Lasting. Minimal Downtime.

x. Expanded Reach Test

Eligible

6.00%

$23.30

Real Success Stories. FDA Cleared. Is Freezing Fat Right
For You? Book a Free CoolSculpting Consultation Today
+ More .
Huge CoolSculpting Promotion | CoolSculpting in Staten
Island | 2021 CoolSculpting Discount +6 more
M e www.natalyachalikmd.com
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0. coolsculpting - general Removed 5 5.75% 82275

259-215-0574 Chris Zelig
support@medstammedia.com

Chris Zelig > All campaigns > ‘

= 4 Google Ads | EmersonMedical - .. 503346766 v search | beta | coolsculpting

@ Enabled Status: Eligible  Type: Search Budget: 948.83/day Optimization score: 73.4% N More details v

Overview
- Q o 3
Recommendations + Y Adstatus: Al ADD FILTER > ‘ v
Insights A
] e Ad Ad group Status Clicks CTR \ Cost
» Ad groups TN SUNgET Y. VIR DOWTTUT I CeEauimyg CooTSeanpunyg-s
View assets details
~ Ads & extensions CoolSculpting in Staten Island | Jan Only $1,000 Off 8+
Cycles | Flexible Payment Options
www.natalyachalikmd.com
Ads D [x] Expert, Safe Fat Loss With Quick Results. Minimal 0. coolsculpting - general Removed 6 7.32% $23.60
Downtime. Eliminate Fat And Feel Great. Don't Miss Our
Extensions Bxgges} Promo Yet. Book a Free Consultation and Lock In
Your Discount Today
D » Landing pages Non-Surgical Fat Reduction | Our Biggest Discount Ever |
Get $1000 Off 6+ Treatments
www.natalyachalikmd.com s
> Keywords D ® Easy And Convenient. Long-Lasting. Minimal Downtime. X Expanden Heaciesy = J[glp!g g S.00% $2330
Real Success Stories. FDA Cleared. Is Freezing Fat Right
» Audiences For You? Book a Free CoolSculpting Consultation Today
Huge CoolSculpting Promotion | CoolSculpting in Staten
* Demographics Island | 2021 CoolSculpting Discount +6 more
wwiw.natalyachalikmd.com A - 5
: D © Best Prices. FDA-Cleared. Clinically Proven Fat Removal. 0. coolsculpting - general Removed 5 575% S22.75
Settings No Surgery. Minimal Downtime. Leading CoolSculpting...
View assets details
Suggested
CoolSculpting in Staten Island | Limited Time Offer | Jan
» Ad schedule 2021 | Flexible Payment Options
www.natalyachalikmd.com
D (<} Expert, Safe Fat Loss With Quick Results. Minimal 0. coolsculpting - general Removed 5 10.20% §2272

+ More

Downtime. Eliminate Fat And Feel Great. Don't Miss Our
Biggest Promo Yet. Book a Free Consuiltation and Lock In
Your Discount Today

Chris Zelig » All campaigns >

259-215-0574 Chris Zelig

= 4 Google Ads | EmersonMedical - 503346766 v search | beta | coolsculpting support@medstarmedia.com
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Clicks

\ Cost

1429%

100.00%

6.25%

o 2

$0.98

$0.66

$0.51

$0.00

259-215-0574 Chris Zelig
support@medstammedia.com

Overview

Recommendations

Insights

-

Ad groups

~ Ads & extensions

I Ads

Extensions

_D' Landing pages

*» Keywords

» Audiences

» Demographics
Settings

Suggested

* Ad schedule

+ More

® Enabled

Status: Eligible  Type: Search

+ Y Adstatus: Al ADD FILTER

Ad

ey vruna Py way 1w purry
Staten Island | 25% Off CoolSculpting® Special +6 more
wwuw.natalyachalikmd.com

Top CoolSculpting® Provider. Freeze Away Fat. Now 25%
Off + Free Consultation. #1 Coolsculpting Deal 25% Off....
View assets details

Top CoolSculpting® Provider | Freeze Away Fat. Now 25%
Off. | No Surgery, Pain or Downtime
www.natalyachalikmd.com

#1 CoolSculpting® Staten Island. Freeze Away Fat
Without Surgery. 25% Off Deal. CoolSculpting 25% Off: No
Needles, No Surgery, and No Downtime. Free
Consultation.

#1 CoolSculpting Staten Island | 25% Off CoolSculpting®
Special | Freeze Fat Off. Free Consult.
www.natalyachalikmd.com

Top CoolSculpting® Provider. Freeze Away Fat. Now 25%
Off + Free Consultation. #1 Coolsculpting Deal 25% Off.
#1 Non-Surgical Fat Reduction Procedure in the World.

{KeyWord: #1 Coolsculpting Deal} | #1 CoolSculpting
Staten Island | 25% Off CoolSculpting® Special +6 more
www.natalyachalikmd.com

Top CoolSculpting® Provider. Freeze Away Fat. Now 25%
Off + Free Consultation. #1 Coolsculpting Deal 25% Off....
View assets details

Total: Ads @

Total: Campaign @

Budget: $48.83/day

Optimization score: 73.4% I

Ad group

SKAG | coolsculpting face | BROAD

SKAG | coolsculpting face | BROAD

SKAG | coolsculpting face | BROAD

SKAG | how much is coolsculpting | EXACT

More details v

Status

Not eligible

Not eligible
Ad group removed

Not eligible
Ad group removed

Not eligible

Q =

ACH  SEGMENT

Clicks

942

942

7.31%

7.31%

\J» Cost

$0.00

$0.00

$0.00

$0.00

$3277.04

$3277.04




— Chris Zelig > All campaigns > 259-215-0574 Chris Zelig
= 4 Google Ads | EmersonMedical- .. ssoas46766 ~ | search| betal coolsculpting C @ R .poemesmedsocon
N @ Enabled Status: Eligible Type:Search  Budget: $51.65/day Optimization score: 73.4% I = More details v
) Extensions >
Recommendations == I-I-i Cl v £ >
Il ~ X SUMMARY  TASLE
Insights
Y  Extensiontype: All  ADD FILTER Associations view ¥ il
» Ad groups SEGMENT REPORTS D
I ~ Ads & extensions O Extension Extension type Added to Level Status Clicks CTR 4 Cost
Ads Sitelink extension
Extensions Full Range of Services
D Learn More About Our Complete Range Sitelink extension search | beta | coolscul.. | Campaign Approved 438 6.68% $1,592.18
: of Health & Wellness Services
» Landing pages |

CoolSculpting
» Keywords O CoolSculpting: The Top Non-Surgical Sitelink extension search | beta | coolscul.. = Campaign Approved 428 6.57% $1,556.18
Fat Reduction Treatment. Learn More

» Audiences About Us
D Learn More About Our Team, Location Sitelink extension search | beta | coolscul.. = Campaign Approved 421 6.55% $1,529.23

» Demographics and Available Beauty Treatments.

; Book A Free Consultation
Settings D Contact Us Today to Schedule Sitelink extension search | beta | coolscul.. = Campaign Approved 420 6.51% $1,527.16
Your Free Consultation
Suggested
Call extension
* Ad schedule
|:| (718) 448-3800 Call extension Account Account Approved 35 452% $123.01
+ More .
O ,(;1:;]?8‘3800 Call extension Account Account Approved 33 3.50% $120.13
\ )

= 4 G | Ad Chris Zelig > All campaigns > c 0 ‘ 259-215-0574 Chris Zelig
= 00gl€ AGS | EmersonMedical - ... 5503346766 v | search | beta | coolsculpting support@medstarmedia.com
Guoview @ Enabled Status: Eligible  Type: Search Budget: $51.65/day Optimization score: 73.4% NN More details v
7 — ,‘ ra -
Recommendations Y Extensiontype: Al ADD FILTER Associations view ¥ ‘ — = L4 :
SEGMENT DOWNLOAD EXPAI MORE
Insights =
] Extension Extension type Added to Level Status Clicks CTR J Cost
» Ad groups
Book A Free Consultation
~ Ads & extensions O Contact Us Today to Schedule Sitelink extension search | beta | coolscul.. = Campaign Approved 420 6.51% $1,527.16
Your Free Consultation
Ads Call extension
Extensions
(718) 448-3800 Call extension Account Account Approved 35 452% $123.01
D' Landing pages
| D &1:3.:&3800 £ Call extension Account Account Approved 33 3.50% $120.13
* Keywords
Location extension
» Audiences
D :lalrlalyai?dnﬁ@‘laotcgm s - Location extension Account Account - - - -
» Demographics geanons Secls
B Callout extension |
Settings
D FDA Cleared Callout extension search | beta | coolscul.. ~ Campaign Approved 179 7.25% $608.01
Suggested
* Ad schedule Applroved (limited):
3 y g Health i
O Liposuction Alternative Callout extension search | beta | coolscul.. = Campaign pee;onlar;ize d 156 8.29% §572.10
+ More . advertising
O Freeze Your Fat Callout extension search | beta | coolscul.. = Campaign Approved 152 7.05% $524.30

= 4 G | Ad Chris Zelig » All campaigns > c 0 ‘ 259-215-0574 Chris Zelig
= 00gle AGS | Emerson Medical - .. 5503346766 ¥ search | beta | coolsculpting support@medstarmedia.com
OvEnicw @ Enabled Status: Eligible  Type: Search Budget: $51.65/day Optimization score: 73.4% NN More details v
) Extensions > ' o=
Recommendations =1 Il v < >
I~ x :
SUMMARY TABLE
Insights
. ; A = ¥ £ :
Y  Extension type: Al ADD FILTER Associations view ¥ - m il - L .
» Ad groups SEGMENT COLUMNS REPORTS DOWNLOAD  EXPAND  MORE
I ~ Ads & extensions O Extension Extension type Added to Level Status Clicks CTR J Cost
Ads Callout extension
Extensions D New Clients 25% Off Callout extension search | beta | coolscul.. = Campaign Approved 130 6.78% $473.24
D’ Landing pages Applroved (limited):
| I Health i
D Highlights: No Surgery Callout extension search | beta | coolscul.. =~ Campaign pe?son;?ized 137 7.17% $469.10
*» Keywords advertising
* Audiences D Contact Us + Free Consult Callout extension search | beta | coolscul.. = Campaign Approved 128 6.89% $436.60
* Demographics O Nonsurgical Fat Reduction Callout extension search | beta | coolscul.. = Campaign Approved 121 6.75% 542041
Settings Structured snippet extension
Suggested Service catalog: CoolSculpting, Non- 4
D Surgical Liposuction, Cellulite Reduction, ?x;ﬁ:;d snippet search | beta | coolscul.. = Campaign Approved 6 3.30% $19.39
» Ad schedule Double Chin Reduction, Coolmini, Fat... :
+ More " Promotion extension
D Spring Sale - $1,000 off 6+ Treatments Promotion extension search | beta | coolscul.. = Campaign Approved 59 7.11% $178.58

p— ‘ G | Ad Chris Zelig » All campaigns > c o ‘ 259-215-0574 Chris Zelig
— 00gle AGS | Emerson Medical - .. 5503346766 ¥ | search | beta | coolsculpting support@medstarmedia.com
Overviow @ Enabled Status: Eligible  Type: Search Budget: $51.65/day Optimization score: 73.4% N More details v
: " ; : = m m ¥ £ .
Recommendations Y Extensiontype: Al ADD FILTER Associations view ¥ ‘ = = o
SEGMENT COLUMNS REPORTS DOWNLOAD EXPAND MORE
Insights
D Extension Extension type Added to Level Status Clicks CTR J Cost
» Ad groups DOUDrE T RECUCTION, COOITI, Fat
I ~ Ads & extensions Promotion extension
Ads D Spring Sale - $1,000 off 6+ Treatments Promotion extension search | beta | coolscul.. = Campaign Approved 59 7.11% $178.58
Extensions Total: Sitelink extensions 447 6.73% $1,630.28
D » Landing pages Total: Callout extensions 380 7.36% $1,328.93
* Keywords Total: Structured snippet extensions 6 3.30% $19.39
» Audiences Total: Call extensions 68 3.96% 524314
> Demographics Total: Location extensions 450 7.04% $1,566.04
Settings Total: Promotion extensions 591 8.57% $2,137.03
Suggested
Showrows: 10 ¥ 11-160f16 K <
* Ad schedule
4+ More . Reporting s not real-time. Time zone for all dates and times: (GMT-04:00) Eastern Time. Leam more
Some inventory may be provided through third party intermediaries.
You'll see Media Rating Council (MRC) accreditation noted in the column header's hover text for accredited metrics.
© Google, 2021

= 4 G | Chris Zelig > All campaigns > \ c 0 ‘ 259-215-0574 Chris Zelig
= oogle AdS | EmersonMedical - .. 5503346766 v | search | beta | coolsculpting support@medstarmedia.com
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nsights
ASSETS COMBINATIONS
» Ad groups
I ~ Ads & extensions Responsive search ads usually need around 5,000 impressions over 30 days to display a rating in the Performance column. Learn more
Ads o
o Y Assetstatus: Al ADD FILTER -
Extensions D EPAND
D’ Landi @® Asset Status Asset type Position pinning Impr.
anding pages
» Keywords @ Freezing Fat Really Works Approved Headline None 10
» Audiences @ Our Biggest Discount Ever Approved Headline None 66
» Demographics © Offering $1,000 Off Right Now - Headline None 0
Settings @ Emerson Medical Approved Headline None 205
Suggested @ Safe + Effective Fat Reduction Approved Headline None 48
* Ad schedule o y
@® Eliminate Fat & Feel Great Approved Headline None 6
<+ More .
@ Fat Reduction on Staten Island Approved Headline None 1,384

@ Non-Surgical Fat Reduction Approved Headline None 443
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= A Google Ads | emersonMedical- .. ss03346766 v search | beta | coolsculpting Toose support@medstarmedia.com

SETTINGS

OVEvicw @ Enabled Status: Eligible  Type: Search Budget: $51.65/day Optimization score: 73.4% NN More details v
7 ‘ r1
Recommendations Y Assetstatus: Al ADD FILTER ek o
Insights = -
® Asset Status Asset type Position pinning Impr,
» Ad groups e it 2z
I ~ | Afls & extensions © Offering $1,000 Off Right Now - Headline None 0
Ads @ Emerson Medical Approved Headline None 205
Extensions @ Safe + Effective Fat Reduction Approved Headline None 48
p » Landing pages @ Eliminate Fat & Feel Great Approved Headline None 6
» Keywords @ Fat Reduction on Staten Island Approved Headline None 1,384
» Audiences @ Non-Surgical Fat Reduction Approved Headline None 443
> Demographics © October 2020 Deal $1,000 Off - Headline None 0
Settings © November 2020 Deal $1,000 Off =t Headline None 0
Suggested
Showrows: 10 ¥ 1-100f23 > Dl
* Ad schedule
S e ., Reportingis not real-time. Time zone for all dates and times: (GMT-04:00) Eastern Time. Learn more
Some inventory may be provided through third party intermediaries.
You'l see Media Rating Council (MRC) accreditation noted in the column header's hover text for accredited metrics.
© Google, 2021.
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Recommendations Ads >
" Responsive searchad X Leave feedback cH BRSNS v ¢
nsights
ASSETS COMBINATIONS
» Ad groups
I ~ Ads & extensions Responsive search ads usually need around 5,000 impressions over 30 days to display a rating in the Performance column. Learn more
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» Keywords © Offering $1,000 Off 8+ Cycles - Headline None 525
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Settings © 51300 Off 8+ Treatments - Headline None 391
Suggested @ Get $1000 Off 6+ Treatments Approved Headline None 0
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+ More .
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D b Londing pages ° gzs\;niirrﬁ:s. FDA-Cleared. Clinically Proven Fat Removal. No Surgery. Minimal Approved Description None 842
» Keywords @ s Freezing Fat Right For You? Book a Free CoolSculpting Consultation Today Approved Description None 3
- Our Biggest CoolSculpting Discount Ever. Available Now: Get $1,000 Off _ L
» Audiences [x] CoolSculpting. Description None 0
» Demographics ° [E:laes;rreA:d Convenient. Long-Lasting. Minimal Downtime. Real Success Stories. FDA Appeoved Deseription Riaies 1,503
Settings © Our Biggest CoolSculpting Discount Ever. Save $1,000 Off 8+ Cycles of CoolSculpting.  — Description None 4
Suggested
Showrows: 10 ¥ 11-200f23 <K < >
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COOLSCULPTING
MARKETING

CoolSculpting Marketing Management

Guava Jelly

12 E22nd ST

PHF

New York City, New York NY, 10010
United States

6467023480
BILL TO Invoice Number: 2020_DM_50
Dr. Natalya Chalik
Dr. Natalya Chalik Invoice Date: January 1, 2021
Nata'yamd25@ao|_com Payment Due: January 1, 2021

Amount Due (USD): $0.00

Services Hours Rate Amount
Coolsculpting Monthly Marketing 4.5 $200.00 $900.00

Digital Marketing & Content Management

- Manage & optimize digital marketing campaigns on
Google Adwords

-website and content optimization plus use of optin
technology to increase conversions.

-CoolSculpting optimized content creation

CoolSculpting Digital Advertising 0.333 $1,200.00 $399.60
Coolsculpting Email Marketing- 1 custom-designed

Coolsculpting Email Blast with 1 resend to

nonopeners

Payment 1/3 (Total $1200)

Total: $1,299.60
Payment on February 1, 2021 using ending in 2003: $1,299.60
Amount Due (USD): $0.00

Please make check payable to Guava Jelly
Please send check to Chris Zelig 12E. 22nd ST #PHF, New York, NY 10010



COOLSCULPTING
MARKETING

CoolSculpting Marketing Management

Guava Jelly
12 E22nd ST
PHF

New York City, New York NY, 10010

United States

6467023480
BILL TO Invoice Number: 2020_DM_51
Dr. Natalya Chalik
Dr. Natalya Chalik Invoice Date: February 1, 2021
Nata'yamd25@ao|_com Payment Due: February 1, 2021
Amount Due (USD): $0.00
Services Hours Rate Amount
Coolsculpting Monthly Marketing 4.5 $200.00 $900.00
Digital Marketing & Content Management
- Manage & optimize digital marketing campaigns on
Google Adwords
-website and content optimization plus use of optin
technology to increase conversions.
-CoolSculpting optimized content creation
Total: $900.00
Payment on March 2, 2021 using ending in 2003: $900.00
Amount Due (USD): $0.00

Please make check payable to Guava Jelly
Please send check to Chris Zelig 12E. 22nd ST #PHF, New York, NY 10010



COOLSCULPTING
MARKETING

CoolSculpting Marketing Management

Guava Jelly
12 E22nd ST
PHF

New York City, New York NY, 10010

United States

6467023480
BILLTO Invoice Number: 2020_DM_55
Dr. Natalya Chalik
Dr. Natalya Chalik Invoice Date: March 1, 2021
Nata'yamd25@ao|_com Payment Due: March 1, 2021
Amount Due (USD): $0.00
Services Hours Rate Amount
Coolsculpting Monthly Marketing 4.5 $200.00 $900.00
Digital Marketing & Content Management
- Manage & optimize digital marketing campaigns on
Google Adwords
-website and content optimization plus use of optin
technology to increase conversions.
-CoolSculpting optimized content creation
Total: $900.00
Payment on April 1, 2021 using ending in 2003: $900.00
Amount Due (USD): $0.00

Please make check payable to Guava Jelly
Please send check to Chris Zelig 12E. 22nd ST #PHF, New York, NY 10010



